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The Development Environment
Point of View incorporates a modern, Ribbon-based Windows interface to provide an integrated 
and user-friendly development environment.

The POV Development Environment
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Title Bar
The Title Bar located along the top of the development environment displays the application name 
(e.g., Point of View) followed by the name of the active screen or worksheet (if any). 

The Title Bar also provides the following buttons (from left to right):

• Minimize button : Click to minimize the development environment window to the Taskbar.

• Restore Down / Maximize: Click to toggle the development environment window between two 
sizes:

• Restore Down button reduces the window to its original (default) size.

• Maximize button enlarges the window to fi ll your computer screen.

• Close button : Click to save the database and then close the development environment. If 
you modifi ed any screens or worksheets, the application prompts you to save your work. This 
button’s function is similar to clicking Exit Application on the Application menu.

NOTE: Closing the development environment does not close either the project viewer or the runtime system, if 
they are running.

Example of Title Bar
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Status Bar
The Status Bar located along the bottom of the development environment provides information 
about the active screen (if any) and the state of the application.

The Status Bar fi elds (from left to right) are described in the following table:

Example of Status Bar

Field Description
Execution Mode The current execution mode of the application.

CAP Indicates whether the keyboard Caps Lock is on
(black) or off (grey).

NUM Indicates whether the keyboard Num Lock is on
(black) or off (grey).

SCRL Indicates whether the keyboard Scroll Lock is on
(black) or off (grey).

Object ID The ID number of a selected screen object.

Cursor Position

The location of the cursor on the active screen or
worksheet. If it’s a screen, then the position of the
mouse cursor is given as X,Y coordinates, where X is
the number of pixels from the left edge of the screen
and Y is the number of pixels from the top edge of the
screen. If it’s a worksheet, then the position of the text
cursor is given as Line and Column.

Object Size The size (in pixels) of a selected screen object, where
W is the width and H is the height.

No DRAG Indicates whether dragging is disabled (No DRAG) or
enabled (empty) in the active screen.

Tag Count The total number of tags used so far in the project.
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Application Button
The Application button opens a menu of standard Windows application commands like New, 
Open, Save, Print, and Close.

Application Button Opens Menu of Commands
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Quick Access Toolbar
The Quick Access Toolbar is a customizable toolbar that contains a set of commands that are 
independent of the ribbon tab that is currently displayed.

Move the Quick Access Toolbar
The Quick Access Toolbar can be located in one of two places:

• Upper-left corner next to the Application button (default location); or

• Below the ribbon, where it can run the full length of the application window.

If you don’t want the Quick Access Toolbar to be displayed in its current location, you can move it 
to the other location: 

1) Click Customize Quick Access Toolbar          .

2) In the list, click Show Below Ribbon or Show Above Ribbon.

Add a Command to the Quick Access Toolbar
You can add a command to the Quick Access Toolbar directly from commands that are displayed on 
the ribbon:

1) On the ribbon, click the appropriate tab or group to display the command that you want to 
add to the Quick Access Toolbar.

2) Right-click the command, and then click Add to Quick Access Toolbar on the shortcut menu.

You can also add and remove commands — as well as reset the toolbar to its default — using the 
Customize dialog:

1) Click Customize Quick Access Toolbar . 

2) In the list, click More Commands. 
The Customize dialog is displayed.

3) In the Choose commands from 
menu, select the appropriate 
Ribbon tab. The commands 
from that tab are displayed in the 
Commands list.

4) In the Commands list, select the 
command that you want to add to 
the Quick Access Toolbar.

5) Click Add.

Only commands can be added to the 
Quick Access Toolbar. The contents of 
most lists, such as indent and spacing 
values and individual styles, which also 
appear on the ribbon, cannot be added 
to the Quick Access Toolbar. Customize Quick Access Toolbar Dialog
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Ribbon
The ribbon combines the numerous menus and toolbars into a single, user-friendly interface. 
Almost all application commands are on the ribbon, organized into tabs and groups according to 
general usage.

Home Tab
The Home tab of the ribbon is used to manage your project within the development environment.

The tools are organized into the following groups:

• Clipboard: Cut, copy, paste, and fi nd items in project screens and task worksheets.

• Local Management: Run and stop the project on the local station (i.e., where the development 
application is installed), as well as manage the execution tasks.

• Remote Management: Connect to a remote station so that you can download the project to it, 
and then run, stop, and troubleshoot the project on that station. For more information, see the 
“About remote management” help fi le topic.

• Tools: Miscellaneous tools to verify the project, import tags from other projects, convert screen 
resolutions, and register ActiveX and .NET controls.

• Tags: Manipulate tags and tag properties in the project database.

View Tab
The View tab of the ribbon is used to customize the look of the development environment itself.

The tools are organized into the following groups:

• Show/Hide: Show and hide the different parts of the development environment, as well as restore 

The Ribbon Interface

Home Tab of the Ribbon

View Tab of the Ribbon
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the default layout.

• Zoom: Zoom in and out of the screen editor.

• Options: Change the language and font used in the development environment.

• Window: Arrange the windows in the development environment.

Insert Tab
The Insert tab of the ribbon is used to insert new tags, screens, worksheets, and other components 
into your project.

The tools are organized into the following groups:

• Global: Insert tags, classes, translations, and procedures into the Global tab of the Project 
Explorer.

• Graphics: Insert screens and screen groups into the Graphics tab of the Project Explorer.

• Task Worksheets: Insert task worksheets into the Tasks tab of the Project Explorer.

• Communication: Insert server confi gurations and communication worksheets into the Comm tab 
of the Project Explorer.

Project Tab
The Project tab of the ribbon is used to confi gure your project settings.

The tools are organized into the following groups:

• Settings: Confi gure the general project settings or set the project to run as a Windows service.

• Security System: Enable and confi gure the project security system.

• Web: Confi gure the project to accept connections from a variety of thin clients.

Insert Tab of the Ribbon

Project Tab of the Ribbon
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Graphics Tab
The Graphics tab of the ribbon is used to draw project screens.

NOTE: This tab is available only when you have a project screen open for editing.

The tools are organized into the following groups:

• Screen: Confi gure settings for the project screen itself, such as its attributes, script, and 
background color or image.

• Editing: Select and edit objects in the project screen.

• Shapes: Draw static lines and shapes.

• Active Objects: Draw active objects, like buttons and check boxes.

• Data Objects: Draw objects that display historical data, like alarms, events, and trends.

• Libraries: Select from libraries of premade objects, such as symbols, .NET and ActiveX controls, 
and external image fi les.

• Animations: Apply animations to other screen objects.

Format Tab
The Format tab of the ribbon is used to format and arrange objects in a project screen.

NOTE: This tab is available only when you’ve selected one or more objects in a project screen.

The tools are organized into the following groups:

• Arrange: Arrange objects in a project screen, including bring to front and send to back, group, 
align, and rotate.

Format Tab of the Ribbon

Graphics Tab of the Ribbon
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• Position: Precisely adjust the position of a screen object in a project screen.

• Size: Precisely adjust the size of a screen object.

• Style: Change the fi ll and line color of a screen object.

• Fonts: Change the caption font of a screen object.

Help Tab
The Help tab of the ribbon provides additional help with using the software.

The tools are organized into the following groups:

• Documentation: Access the documentation for the development application, including this help 
fi le/technical reference and notes for the individual communication drivers.

• Information: Access other information about Point of View, including the license agreement, 
product website, and release notes, as well as system and support details that make it easier for 
Customer Support to assist you.

Help Tab of the Ribbon
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Project Explorer
The Project Explorer organizes all of the screens, worksheets, and other items that comprise your 
project and presents them in an expandable tree-view.
To open a folder and view its contents, either click the Expand icon to the left of the folder or 
double-click the folder itself.
To close a folder, click the Collapse icon to the left of the folder.
If you right-click any item in the Project Explorer, then a shortcut menu will appear with contextual 
commands for that item.
There are four main sections, or tabs, in the Project Explorer: Global, Graphics, Tasks, and Comm.

Global Tab
The Global tab of the Project Explorer contains the project tags database, as well as other features 
that apply to the entire project such as the security system, VBScript procedures, and UI translation.

The folders on the Global tab are described in the following sections:

• Project Tags: The project tags database contains all of the data tags that you create during project 
development, such as screen tags (e.g., button1_state) or tags that read from / write to connected 
devices.

• Classes: Classes are compound tags that you can create to associate a set of values, rather than a 

Global Tab of the Project Explorer
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single value, with an object. For example, where you may normally create separate tags for a tank’s 
pressure, its temperature, and its fi ll level, you can instead create a “tank” class that includes all 
three.

• Shared Database: The shared database contains tags that were created in another program and 
then imported into or integrated with your project.

•  System Tags: System tags are predefi ned values such as the date, the time, the name of the current 
user, and so on. You can use these values to develop supervisory functions and housekeeping 
routines.
You cannot add, edit, or delete these tags from the database.

• Security: If you choose to enable it, you can use the project security system to control who may 
log on to your project and what they may do during runtime.

• Procedures: Procedures are VBScript functions and sub-routines that can be called by any other 
script in your project.

• Event Logger: The event logger saves important runtime messages and task results to an external 
database.

• Translation: You can use the translation table to develop a multilingual user interface (MUI) for 
your project.

Graphics Tab
The Graphics tab of the Project Explorer contains all of the screens, screen groups, and symbols in 
your project.

Graphics Tab of the Project Explorer
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The folders on the Graphics tab are described in the following sections:

• Screens: You create screens to provide a graphical interface for your project. Each screen can 
contain many buttons, sliders, dials, indicators, graphs, and so on.

• Screen Groups: You can combine individual screens into screen groups, so that they all open 
together at the same time.

• Thin Clients: You can deploy your project as a web application to be accessed by thin clients such 
as desktop web browsers, tablets, and smartphones. You can even deploy different versions of your 
project with different levels of functionality for each type of client.

• Project Symbols: This folder contains all of the custom symbols that you create for your project. 
A symbol is a group of interconnected screen objects that work together to perform a single 
function — for example, lines, rectangles, and text fragments that have been arranged to make a 
slider control.

• Graphics Script: You can use this worksheet to defi ne VBScript sub-routines that are called only 
when the graphics module starts (i.e., when a client station connects to the server and displays the 
graphical interface), while it is running, and when it ends.

• Symbols: The symbols library contains not only the custom symbols that you create (see 
Project Symbols above), but also a large selection of premade symbols that are installed with the 
development application.

• Layout: The layout editor displays all of the screens the are currently open for editing. You can use 
it to visualize how the screens are arranged together and reuse screens in multiple layouts — for 
example, to create a common navigation bar across your entire project.

Tasks Tab
The Tasks tab of the Project Explorer organizes the 
worksheets that are processed as background tasks 
(i.e., server-based maintenance tasks that are not 
directly related to screen operations or device I/O) 
during project runtime.

The folders on the Tasks tab are described in the 
following sections:

• Alarms: You can use Alarm worksheets to 
defi ne when alarms are trigged, how they must 
be handled, and what messages they generate.
(You can then use the Alarm/Event Control 
screen object to display your alarms on screen, 
but that is a separate procedure.)

• Trends: You can use Trend worksheets to select 
project tags that should be displayed as data 
trends and/or saved as historical data.
(You can then use the Trend Control screen 
object to actually display your trends on 
screen, but that is a separate procedure.)

Tasks Tab of the Project Explorer
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• Recipes: You can use Recipe worksheets to select project tags that will load values from and/or save 
values to an external fi le. These worksheets are typically used to execute process recipes, but you 
can store any type of information such as passwords, operation logs, and so on.
(You can then call the Recipe function to actually run a confi gured Recipe worksheet, but that is a 
separate procedure.)

• Reports: You can use Report worksheets to design runtime reports that are either sent to a printer 
or saved to disk. (You can then call the Report function to actually run a confi gured Report 
worksheet, but that is a separate procedure.)

• ODBC: You can use ODBC worksheets to set up connections and exchange data with other 
ODBC-compliant databases.

• Math: You can use Math worksheets to develop complex runtime logic using the built-in scripting 
language.

• Script: You can use Script worksheets to develop complex runtime logic using VBScript.

• Scheduler: You can use Scheduler worksheets to run commands at specifi ed times, dates, or 
trigger events.

• Database: You can use Database worksheets to set up connections and exchange data with 
external databases using the standard ADO.NET interface (as an alternative to ODBC).

Comm Tab
The Comm tab of the Project Explorer organizes the worksheets that control communication with 
remote devices, using either direct communication drivers or other common protocols.

Comm Tab of the Project Explorer
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The folders on the Comm tab are described in the following sections:

• Drivers: You can use Driver worksheets to communicate with PLCs and other hardware, using 
any of the hundreds of direct communication drivers that are installed with the development 
application.

• OPC DA 2.05: You can use OPC worksheets to communicate with OPC servers via the OPC 
Classic protocol.

• OPC UA: You can use OPC UA worksheets to communicate with OPC servers via the new OPC 
Unifi ed Architecture protocol.

• OPC .Net: You can use OPC .Net worksheets to communicate with OPC servers via the new 
OPC .NET 3.0 protocol (formerly OPC Xi).

• OPC XML/DA: You can use OPC XML/DA worksheets to communicate with OPC servers via 
the new OPC XML-DA protocol.

• TCP/IP: You can use TCP/IP worksheets to confi gure communication between your own project 
and other POV projects. The TCP/IP Client and TCP/IP Server modules enable two or more 
projects to keep their databases synchronized using the TCP/IP protocol.

• DDE: You can use DDE worksheets to communicate with other Microsoft Windows applications, 
such as Microsoft Excel, that support the Dynamic Data Exchange protocol.
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Screen/Worksheet Editor
Use the powerful, object-oriented screen editor to create and edit a variety of screens and worksheets 
for your projects. You can input information using your mouse and keyboard, output control data 
to your processes, and automatically update screens based on data input from your processes.

Other screen editor features include:

• Simple point-and-click, drag-and-drop interface

• Grouping objects to preserve the construction steps of individual objects

• Editing objects without having to ungroup internal object components or groups

• Handling bitmap objects and background bitmaps

• Status line support in project windows and dialogs 

Screen/Worksheet Editor
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